
Advanced Microsoft® 
Office Documents 2007 
Edition Inside Out 

 

 

Stephanie Krieger 
 

 
  

 

 

To learn more about this book, visit Microsoft Learning at 
http://www.microsoft.com/MSPress/books/9491.aspx  

9780735622852 
Publication Date: March 2007  
 



CHAPTER 11

Content Controls:
Creating Forms and Then Some

M icrosoft Word form controls have changed. In fact, they’re not just for forms any-
more. Although the legacy form controls still exist for anyone adverse to saving 

time and getting better results, the new Content Controls functionality in Microsoft 
Offi ce Word 2007 offers very good news for the rest of us. 

As you might have gathered from that introduction, this isn’t the place to learn about 
the legacy form controls that you know from the past several versions. They’re still there 
because the new Content Controls aren’t available to legacy documents. But this book is 
about the 2007 Microsoft Offi ce release, and so this chapter focuses on understanding 
and working with the new, and outrageously improved, Content Controls capability.

That said, keep in mind that Content Controls are a new type of functionality—not 
intended to be a direct replacement of the legacy controls. You’ll notice, for example 
that there are no check boxes. However, if you look at Content Controls and think they 
don’t have what you need for a particular project, consider automating the document 
input using a dialog box instead of resigning yourself to legacy form controls.

With all the Microsoft Offi ce template automation I do, I’ve never once used the legacy 
form controls in a document unless a client absolutely insisted, because they’re cumber-
some to create and to use and, frankly, they’re ugly. When I’ve needed to automate tem-
plates for user input in the past, I’ve always created dialog boxes using Microsoft Visual 
Basic for Applications (VBA). 

Creating and automating dialog boxes is pretty quick and easy to do, and you can learn 
the basics of how to do this in Chapter 21, “VBA Primer.” But, the new XML-based Con-
tent Controls further simplify quite a bit of that work. So, there will be times when a 
dialog box is no longer needed. Content Controls are so user-friendly that they’ve been 
integrated with several built-in features of Offi ce Word 2007. And, you can create your 
own for forms and many document uses. If you create just about any type of Word doc-
uments and templates for others to use, or that you frequently reuse, you need to know 
about Content Controls.

Chapter Assumptions
This chapter assumes that you have some familiarity with form control terminology 
(such as drop-down list and date picker), as well as at least a basic understanding of docu-
ment properties and document protection.
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Chapter 11
Additionally, this chapter makes several references to Document Building Blocks and 
other types of Quick Parts functionality that are integrated with Content Control func-
tionality. If you’re not familiar with these new capabilities, you’ll get more out of this 
chapter if you review Chapter 9, “Quick Parts,” before continuing here.

Although Content Controls are new functionality, you’re not new users of Microsoft 
Word. So, I’m approaching this feature, like all topics throughout this book, from an 
advanced perspective. This chapter covers the use of Content Controls from the user 
interface, and it explains the types of automation available with Content Controls. 
However, coverage of how to work with Content Controls using XML is addressed pri-
marily in Chapter 22, “Offi ce Open XML Essentials.” If you’re new to Content Controls, 
consider this chapter a prerequisite for working with this feature in Chapter 22.

In the introduction to this book, you can fi nd a list of resources for those who want more 
basic-level information, in the section titled “Who Will Benefi t Most from This Book.”

Working with Content Controls
A Content Control is, essentially, a container that enables you to store and act on dif-
ferent types of document content. Some of these controls are simply placeholders for 
text or other content, some enable your users to select from choices of content that you 
specify, and some provide additional types of functionality to help you do more with 
the content they contain. All Content Controls are XML-based, so they enable you to 
take advantage of XML data storage and sharing capabilities to get more done in your 
documents with less work.

As shown in Chapter 9, you can recognize a Content Control in a couple of ways. When 
you hover over any Content Control, it appears shaded (blue in most color schemes), as 
shown here on the left. When you click in or otherwise activate a control, you either see 
a tag at the top that contains a title, such as Name in the example shown here on the 
right, or a similar tag on the left of the control that contains no text. The tag that ap-
pears at the top may have additional icons that provide other functionality for the con-
tent within the control. (When working in Draft view, however, only the content within 
the control is visible and not the control itself.)

        

Most controls contain placeholder text or other placeholder content until user content 
is added. If a control contains placeholder content, that content will be selected when 
you click in the control. If the control has already been edited by a user, you see the 
border of the control when you click in it, but text won’t automatically be selected. 
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Types of Content Controls
Seven types of Content Controls are available, as follows.

Control Description

Rich Text A Rich Text control can contain text, tables, graphics, and most formatting that you can 
apply in the body of the document. A single Rich Text control can also contain multiple 
paragraphs.

Plain Text A Plain Text control can contain text as well as common font and paragraph formatting. 
These controls can’t take tables or graphics and can only contain a single paragraph. 
(Note that Plain Text Properties in the Content Control Properties dialog box include an 
option to allow multiple paragraphs. The label on that option is incorrect, as explained 
later in this chapter.) 

Text Wrapping breaks can be inserted into Plain Text controls from the Breaks options 
on the Page Layout tab. Depending on the settings for the individual controls, however, 
manual line breaks (SHIFT+ENTER) may not be available in Plain Text controls. 

If you press the TAB key from a Plain Text control, your insertion point moves to the next 
Content Control. To add a tab character inside a Plain Text control, press CTRL+TAB.

Picture A Picture control lets you click the placeholder to add a picture from your saved picture 
fi les. Once a Picture control contains a picture, click the picture icon on the tab contain-
ing the control name to change the picture, or right-click the image and select Change 
Picture. See Chapter 7, “Managing Graphics,” to learn more about the Change Picture 
command, which is available to all pictures in your Word 2007 documents. (Note that 
when a Picture control in a header or footer contains a placeholder, you can click the 
placeholder to add your image when working in Print Layout view without having to 
open the header or footer.)

Drop-Down 
List

A Drop-Down List control gives you the ability to add multiple content choices from 
which users can select. With this control type, users can only select from the options pro-
vided and can’t type text directly into the control. Click the arrow on the right side of the 
control to access the list of options.

Combo Box Like a Drop-Down list, a Combo Box control gives you the ability to add multiple content 
choices from which users can select. However, with a Combo Box, users can type text di-
rectly in the control or select from the options provided. Click the arrow on the right side 
of the control to select from the list of options.

Similar to a Plain Text control, a Combo Box control can’t accept tables or graphics. 
Combo Box controls are designed to only allow a single line of text, but you can insert a 
Text Wrapping Break from the Breaks options on the Page Layout tab.

Date Picker Similar to a Combo Box control, a Date Picker enables you to add text to a control or 
select from options. In this case, click the arrow on the right side of the control for a 
calendar from which you can select a date.

Building 
Block 
Gallery

The Building Block Gallery Content Control enables you to select a Building Block gallery 
to be accessible from the Content Control. This control type has the same behavior as 
Rich Text controls in addition to the ability to select a gallery option. Once you assign a 
gallery to a control, that gallery is accessible at a click from an icon on the tab at the top 
of the control.

Note that not all built-in galleries are available to Building Block Gallery controls, but all 
custom galleries are. 
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Built-In Features That Use Content Controls

The new Quick Parts functionality is heavily integrated with Content Controls. Many 
built-in Building Block entries include Content Controls, such as cover pages, headers, 
and footers. Some other types of built-in Building Block entries (such as tables of con-
tents, bibliographies, and equations) are wholly contained in Content Controls. Addi-
tionally, Document Property Quick Parts are all created using Content Controls.

Notice that, in instances where an entire Building Block entry is stored within a con-
trol, the control provides additional functionality, such as the ability to update a table of 
contents or bibliography, or formatting and layout options for equations. 

See Chapter 9 to learn about how Quick Parts work with Content Controls.

Note
In addition to Quick Parts, Content Controls are used in most of the built-in Word 

templates. 

 
If you insert a DATE fi eld by any method (using the Date And Time dialog box, using 

the Field dialog box, or creating the fi eld on screen), it appears to be inside a Content 

Control. In fact, this will happen whether you’re working in a Word 2007 document or a 

legacy document, the latter of which is not even compatible with Content Controls.

This is simply an anomaly. Call it an undocumented feature, if you will. The DATE fi eld 

does no harm in its slightly odd condition, and it has a nice little bonus of an Update icon 

on the tag at the top of the control, which does the same thing as pressing F9 to update 

a selected fi eld. 

However, if you’re working in a Word 2007 document, take advantage of the added 

functionality available to some types of controls and consider if a Date Picker control can 

possibly do the job more effectively.

Using Content Controls
When you use Content Controls that already exist in a document, such as in the built-in 
Word templates, you might notice that some disappear when you type in them while 
others can’t be deleted at all. 

Note
In addition to Quick Parts, Content Controls are used in most of the built-in Word 

templates.

SIDE OUT DATE fi elds vs. Date Pickers

If you insert a DATE fi eld by any method (using the Date And Time dialog box, using 

the Field dialog box, or creating the fi eld on screen), it appears to be inside a Content 

Control. In fact, this will happen whether you’re working in a Word 2007 document or a

legacy document, the latter of which is not even compatible with Content Controls.

This is simply an anomaly. Call it an undocumented feature, if you will. The DATE fi eld 

does no harm in its slightly odd condition, and it has a nice little bonus of an Update icon 

on the tag at the top of the control, which does the same thing as pressing F9 to update

a selected fi eld. 

However, if you’re working in a Word 2007 document, take advantage of the added 

functionality available to some types of controls and consider if a Date Picker control can 

possibly do the job more effectively.
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Some controls can be set to be removed when their content is edited. All controls can 
be set to not allow deletion or even to not allow editing. Note also that several types of 
Content Controls can be used with the Document Protection feature, discussed later, 
for documents in which you want to completely manage document layout and allow us-
ers to only edit within designated controls.

You can apply styles and formatting to content inside controls just as you can in the 
body of the document. However, controls can also be formatted to automatically use a 
particular style or formatting when you add content.

Note that placeholder content does print, but the Content Control itself does not.

Creating Controls
To create a new Content Control, on the Developer tab, in the Controls group (shown 
here), just click the type of control you want.

Rich Text

Plain Text

Picture

Combo Box

Drop-Down List

Date Picker Building Block Gallery

When you do, the control will be added at your insertion point and will take on default 
settings for that control. These settings, all of which you can edit for the individual con-
trols you create, are as follows.

O Content controls take on the same formatting as the paragraph into which they’re 
inserted.

O Plain Text controls do not allow line breaks (other than the Text Wrapping Break 
mentioned earlier).

O Every type of control you can create contains placeholder content. For picture 
controls, this is a graphic that you can click to open the Insert Picture dialog box. 
For all other control types, this is text, such as “Click here to enter text” for Rich 
Text and Plain Text controls. This text is formatted with a character style named 
Placeholder Text that applies gray font color by default. Placeholder text format-
ting is separate from the formatting for content you add to controls, so that you 
can easily tell the difference between placeholder text and user-edited text. 

O Controls are not deleted when their placeholder content is edited.

O Users can edit and delete controls.

O Building Blocks Gallery controls default to showing the Quick Parts gallery.
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O Date Picker controls default to displaying selected dates using the Windows Sys-
tem Short Date setting.

Note
The System Short Date setting for Windows is available through the Windows Control 

Panel, under Regional And Language options.

O Combo Box controls have no functionality beyond that of Plain Text controls un-
til you add a list of options to them.

O Drop-Down List controls have no functionality until you add a list of options to 
them.

Formatting Controls and Editing Properties
Once you’ve added a control to your document, you can name the control, customize 
the options provided in the preceding list, and format both the placeholder content and 
the user-edited content within the control.

To edit controls, start by turning on Design Mode. Note that you can access control 
properties without being in Design Mode, but because of additional options that are 
limited to Design Mode, your best bet is to go there whenever you need to edit Content 
Control settings. To turn on Design Mode, on the Developer tab, in the Controls group, 
click Design Mode.

Note
If you don’t see the Developer tab, click the Microsoft Offi ce Button and then click Word 

Options. On the Popular tab, click Show Developer Tab In The Ribbon. Note that this set-

ting is available from the <Program Name> Options dialog box in any program where 

you see the Ribbon. As with many settings on the Popular tab, enabling this setting in 

any of these programs will show the Developer tab in all of them.

When you turn on Design Mode, the tags inside Content Controls become visible, as in 
this example. The tags are the shapes that wrap around the text and sit inside the control.

Note
The System Short Date setting for Windows is available through the Windows Control 

Panel, under Regional And Language options.

Note
If you don’t see the Developer tab, click the Microsoft Offi ce Button and then click Word 

Options. On the Popular tab, click Show Developer Tab In The Ribbon. Note that this set-

ting is available from the <Program Name> Options dialog box in any program where

you see the Ribbon. As with many settings on the Popular tab, enabling this setting in

any of these programs will show the Developer tab in all of them.
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These are XML tags, used to identify the particular control when you want to act on it 
programmatically. XML tags are always paired, as you see here, wrapping around the 
content to which they refer. 

Note
By default, tags on Content Controls have the same name as the title of the control, but 

you can customize this when creating your own controls.

As mentioned in Chapter 9, XML tags are also visible for many types of Quick Parts 
when Design Mode is enabled. These can be very handy for identifying the start and 
end points of various content types when you need to do advanced editing. XML tags 
surrounding Quick Part use the type of Quick Part as the name of the XML tag, such as 
Cover Pages, to make them easy to recognize. This is particularly good to keep in mind 
when working in Design Mode because not all XML tags you see indicate the presence 
of Content Controls.

Editing Control Properties
To edit the settings for a control, click in that control and then, on the Developer tab, in 
the Controls group, click Properties to open the Content Control Properties dialog box. 
When Design Mode is active, Properties is also available from the shortcut menu you 
get when you right-click in a Content Control.

The Content Control Properties dialog box has the same name regardless of the control 
type you’re editing, but the options available in the dialog box change depending on the 
type of control, as detailed in the list that follows.

Note
If you click Properties and a Properties pane opens that shows “ThisDocument Docu-

ment” at the top of the pane, your insertion point is either not inside a Content Control, 

or not inside a control for which you can edit properties (such as the DATE fi eld control 

mentioned earlier or the control surrounding a built-in Table Of Contents Building Block 

entry). Just click the X at the top of that pane to close it, make sure your insertion point is 

inside the control for which you want to edit properties, and then click Properties again.

O General options, shown in the image that follows, are the same for all controls ex-
cept Picture controls, which don’t offer the Style option. See the Inside Out tip in 
this section for how to apply font and paragraph formatting to user-edited content 
in Picture controls.

Note
By default, tags on Content Controls have the same name as the title of the control, but

you can customize this when creating your own controls.

Note
If you click Properties and a Properties pane opens that shows “ThisDocument Docu-

ment” at the top of the pane, your insertion point is either not inside a Content Control,

or not inside a control for which you can edit properties (such as the DATE fi eld control

mentioned earlier or the control surrounding a built-in Table Of Contents Building Block

entry). Just click the X at the top of that pane to close it, make sure your insertion point is 

inside the control for which you want to edit properties, and then click Properties again.
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O Locking options, shown here, are the same for all controls. Note that, if you set 
a control to not allow editing, that control can’t be formatted outside of Design 
Mode. Also note that, because the placeholder content (that is, content added or 
edited while in Design Mode) has its own formatting and doesn’t take on format-
ting you set for user-edited content in the control, formatting needs to be applied 
directly to placeholder content while in Design Mode for that formatting to be 
refl ected in the document.

Note
When setting controls to not be edited or deleted, remember that any user of the docu-

ment has the ability to edit those settings. To keep users from removing or altering con-

trols where you need to control layout or content, use Document Protection along with 

your Content Controls, as discussed later in this chapter.

O With the exception of Picture controls, each control also has control-specifi c 
properties available in this dialog box. As mentioned earlier, these include the 
option to have the control automatically removed when its content is edited. And, 
for Plain Text controls, this also includes the option to allow line breaks. Find 
more information about line breaks in Plain Text controls in a Troubleshooting 
tip within this section.

The control-specifi c properties within this dialog box are where you’ll fi nd the 
option to select a gallery and related category for a Building Block Gallery control, 
or add list items for a Drop-Down List control.

Notice, in the Drop-Down List Properties shown here, that you can add, edit, de-
lete, or reorder list entries. 

Note
When setting controls to not be edited or deleted, remember that any user of the docu-

ment has the ability to edit those settings. To keep users from removing or altering con-

trols where you need to control layout or content, use Document Protection along with 

your Content Controls, as discussed later in this chapter.
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Note
Drop-Down List Properties looks identical in the Content Control Properties dialog box 

for both Drop-Down List and Combo Box controls.

TROUBLESHOOTING
I can’t create multiple paragraphs in a Plain Text control
The Content Control Properties dialog box for Plain Text controls explicitly states that the 

option to allow carriage returns means to allow multiple paragraphs. If you’ve enabled 

that option but still can’t get multiple paragraphs in that control, you’re not wrong. The 

information in that dialog box is wrong.

Allowing “carriage returns” in Plain Text Content Controls doesn’t enable multiple para-

graphs. It enables line breaks (SHIFT+ENTER) only. In fact, if you copy multiple para-

graphs and paste them into a Plain Text control, the paragraph marks will be converted 

automatically to line breaks. 

To get multiple paragraphs in a single Content Control, use the Rich Text control.

 
The left side of the XML tag inside any Content Control stores the formatting for the 

user-edited content in that control. So, to apply a style or formatting, just select the left 

side of the control and apply the formatting you need as if you had selected text. The 

formatting will not appear on placeholder text, but it will automatically be used when 

the content of the control is edited.

Formatting the left tag is interchangeable with the option Use A Style To Format Con-

tents, which appears in the Content Control Properties dialog box. However, it’s a bit 

more fl exible because, in addition to being able to apply linked or character styles, you 

can also apply direct formatting.

Thanks for this very cool tip go to Tristan Davis, a Program Manager at Microsoft in 

charge of Content Controls and other programmability issues for the 2007 release, who 

also provided other insights used in this chapter and in Part 5 of this book, “Templates, 

Automation, and Customization.”

Note that this tip is particularly handy for Picture controls that don’t offer the style op-

tion in the Content Control Properties dialog box. For example, you might want to ap-

ply a style to the Content Control that provides space before or after the paragraph, 

paragraph alignment, or even character spacing and positioning, depending on the 

placement of the Picture control. Keep in mind that paragraph and font formatting only 

applies to graphics formatted with the In Line With Text graphic layout, which is the 

default for Picture Content Controls. See Chapter 7 for more on using font and para-

graph formatting to format graphics.

Note
Drop-Down List Properties looks identical in the Content Control Properties dialog box

for both Drop-Down List and Combo Box controls.

OU S OO G

SIDE OUT Use the XML tags to format user-edited content

The left side of the XML tag inside any Content Control stores the formatting for the

user-edited content in that control. So, to apply a style or formatting, just select the left

side of the control and apply the formatting you need as if you had selected text. The

formatting will not appear on placeholder text, but it will automatically be used when

the content of the control is edited.

Formatting the left tag is interchangeable with the option Use A Style To Format Con-

tents, which appears in the Content Control Properties dialog box. However, it’s a bit 

more fl exible because, in addition to being able to apply linked or character styles, you

can also apply direct formatting.

Thanks for this very cool tip go to Tristan Davis, a Program Manager at Microsoft in

charge of Content Controls and other programmability issues for the 2007 release, who 

also provided other insights used in this chapter and in Part 5 of this book, “Templates,

Automation, and Customization.”

Note that this tip is particularly handy for Picture controls that don’t offer the style op-

tion in the Content Control Properties dialog box. For example, you might want to ap-

ply a style to the Content Control that provides space before or after the paragraph,

paragraph alignment, or even character spacing and positioning, depending on the 

placement of the Picture control. Keep in mind that paragraph and font formatting only

applies to graphics formatted with the In Line With Text graphic layout, which is the

default for Picture Content Controls. See Chapter 7 for more on using font and para-

graph formatting to format graphics.
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TROUBLESHOOTING
I can’t get out of Design Mode
If you turn on Design Mode in a document that contains Content Controls and are then 

unable to turn it off, you should see a message box explaining that Design Mode can’t 

be turned off because placeholder text in a control contains invalid items. Additionally, 

when you click OK in that message box, the offending control should be selected.

When this happens, the most likely culprit is usually a fl oating graphic object included 

in the placeholder text, though this can also happen when all placeholder content is re-

moved or when one control is placed inside another while in Design Mode. 

See Chapter 7 for alternatives to using fl oating objects in your documents and reasons 

you might want to consider them. However, if you must include fl oating objects or other 

invalid items in the placeholder text, save and close the document and then reopen it. 

Design Mode will no longer be active.

Note that fl oating graphics in Content Controls can also make the control look quite odd, 

because controls wrap around their content. 

It’s also worth noting that the issues mentioned here occur in some of the built-in tem-

plates available from the New Document dialog box, in case you’re using those as jump-

ing-off points for creating your own.

Formatting Placeholder and User-Edited Control Content
You must be in Design Mode to add, edit, or format most placeholder content. Any con-
tent you add to the control while in Design Mode automatically becomes placeholder 
content.

To edit the formatting of placeholder text inside a control, the easiest option is to edit 
the Placeholder Text character style. When you do that, new controls you create will 
take on the formatting of your edited style. For help editing styles, see Chapter 5, 
“Styles.” Of course, when your Rich Text controls need to contain more complex format-
ting in placeholder text, such as different styles on different paragraphs, you can use any 
styles or formatting that you need and apply them directly to the placeholder content.

As discussed earlier in this chapter, using the Style option in the Content Control Prop-
erties dialog box, or formatting the left tag inside a control, applies font and paragraph 
formatting to user-edited content in the control. Keep in mind, however, that when you 
make changes to the formatting in a control after the control contains user-edited con-
tent, your changes won’t be refl ected automatically on existing content. If a user adds 
new content at the beginning of the control, it will take on your new formatting. How-
ever, from within existing content, formatting will follow Word formatting rules. That 
is, new content takes on the formatting at the insertion point. 

For best results when changing the formatting of controls that already contain some 
user-edited content, apply the style or formatting you need directly to the existing con-

TROUBLESHOOTING
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tent and update the formatting for the control either by selecting the left tag or through 
the Content Control Properties dialog box. That way, you update the formatting on 
existing content and you’re ensured that future editing will result in the formatting you 
want.

For Picture controls, in addition to using the left tag to apply font and paragraph for-
matting for user-edited content, you can format the picture placeholder to take on the 
formatting you need for the user-added picture. When you select the picture placeholder 
within the Picture control, you get the Picture Tools Format contextual tab. So, you can 
format attributes—such as changing picture size or applying a grayscale effect—and that 
formatting will be retained when the placeholder is replaced with a picture. Note that, 
because picture sizing is proportional by default, if the user-added picture has different 
proportions from the placeholder, the smaller of the dimensions set in the placeholder 
is kept and the user-added picture is resized proportionally.

 
If you add text as placeholder text and later want to reset that placeholder text to the 

default text for that control type, simply delete all placeholder content while in Design 

Mode. When you click outside the control, the default placeholder text will appear. Do 

not, however, cut the entire contents of the user-edited text while in Design Mode be-

cause this will delete the control as well. 

Note that applying the Placeholder Text character style only changes the formatting of 

placeholder content and not its properties. That is, you can’t convert user-edited text to 

placeholder text while in Design Mode just by applying the Placeholder Text style.

To convert user-edited text to placeholder text, do the following.

 1. With Design Mode turned off, select the text you want to convert to placeholder 

text and cut it (CTRL+X). 

Do not select the entire contents of the control because this will delete the control 

as well. If you want to use the entire contents as placeholder text, leave out the last 

paragraph mark when selecting the content to cut.

 2. Turn on Design Mode. Delete (do not cut) the remaining user-edited text and then 

click outside the control. This will reset placeholder text to the default. Note that 

you can take this step before turning on Design Mode, if you prefer, but the step 

that follows must be done in Design Mode.

 3. Paste the content you cut earlier inside the control (CTRL+V). From the Paste 

SmartTag that appears, select the option to match destination formatting.

 4. Turn off Design Mode. The text you pasted in Design Mode should now be 

placeholder text.

SIDE OUT Reset placeholder text or convert user-edited content to 
placeholder text

If you add text as placeholder text and later want to reset that placeholder text to the 

default text for that control type, simply delete all placeholder content while in Design 

Mode. When you click outside the control, the default placeholder text will appear. Do 

not, however, cut the entire contents of the user-edited text while in Design Mode be-

cause this will delete the control as well. 

Note that applying the Placeholder Text character style only changes the formatting of 

placeholder content and not its properties. That is, you can’t convert user-edited text to

placeholder text while in Design Mode just by applying the Placeholder Text style.

To convert user-edited text to placeholder text, do the following.

1. With Design Mode turned off, select the text you want to convert to placeholder 

text and cut it (CTRL+X).

Do not select the entire contents of the control because this will delete the control 

as well. If you want to use the entire contents as placeholder text, leave out the last

paragraph mark when selecting the content to cut.

2. Turn on Design Mode. Delete (do not cut) the remaining user-edited text and then

click outside the control. This will reset placeholder text to the default. Note that 

you can take this step before turning on Design Mode, if you prefer, but the step 

that follows must be done in Design Mode.

3. Paste the content you cut earlier inside the control (CTRL+V). From the Paste

SmartTag that appears, select the option to match destination formatting.

4. Turn off Design Mode. The text you pasted in Design Mode should now be

placeholder text.
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Nesting Controls
You can nest controls in the user-edited content of a control, but not in placeholder
content. 

The only situation where you’re likely to fi nd this useful is when you want to contain a 
large part of a formatted document inside a control. In that case, add the placeholder 
content for the host control as regular user-edited content (that is, not as placeholder 
content at all). Remember that placeholder content can’t be edited outside of Design 
Mode, so when a user clicks in a control that has placeholder content, they either re-
place all of it or none of it. In a case where you want to include a large part of document 
content as placeholder text, it’s likely that you’ll want the user to be able to retain some 
of it, so it should be saved as user-edited text in any case.

If you need to nest controls inside a host control, start with a Rich Text control and add 
the text content you need outside of Design Mode so that the user can edit it. Then, 
while still outside of Design Mode, insert each of the nested controls you need. You can 
later edit any of the controls in Design Mode as needed.

When you click into placeholder text in a control while Design Mode is active, you’ll 
notice that you don’t have the ability to nest new controls within placeholder text. You 
can use a workaround by inserting them separately and then pasting them into your 
placeholder text, but Word will let you know it doesn’t want you to do that, because 
you’ll be unable to exit Design Mode. As with other causes of Design Mode being forced 
to remain on, you can save, close, and reopen the document to turn it off. But, for best 
results, heed Word’s warning here. You can experience usability problems if you try to 
add nested controls as placeholder text within a control. Remember that placeholder 
text is not designed to be edited by the user.

nderstanding Document Protection Options
The same document protection options are available from both the Review tab and the 
Developer tab. When you click Protect Document, as shown here, Restrict Reviewing 
Options refers to what you most likely think of as document protection. The Restrict 
Permission options refer to Information Rights Management (IRM), discussed in
Chapter 2, “Understanding Electronic Documents.” As mentioned in Chapter 2, de-
pending on your edition of the 2007 release, you may or may not see the Restrict Per-
mission options.
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When you click Restrict Formatting And Editing from the Protect Document options, 
the Restrict Formatting And Editing pane opens. The fi rst option in that pane, shown 
here, addresses formatting restrictions, which can also be accomplished from the Man-
age Styles dialog box introduced in Chapter 5.

The options you need for protecting documents so that users can only edit content in-
side controls are under Editing Restrictions.

Four options are available under the Editing Restrictions heading, described as follows.

O The Tracked Changes restriction forces Tracked Changes to remain on, but allows 
any type of editing. This option can only be enabled for the entire document.

O The Comments restriction allows no content editing, but it does allow users to 
add or edit comments. This option has an Exceptions setting that allows you 
to select portions of the document to keep freely editable, and to assign editing 
rights for those exceptions to everyone or just to specifi ed users.

O The Filling In Forms option is one of the options to consider for use with Content 
Controls. This option can be enabled for the entire document or by section. (Note 
that you will only see the option to select sections when multiple sections exist in 
the document.) When you enable forms protection, users can only access or edit 
content inside controls. More specifi cally, users can only add or edit text within 
controls, because formatting and the ability to insert or paste objects is prohib-
ited. The exception to this is Picture controls, to which users can add a picture 
while forms protection is active. However, once a picture is added in a Picture con-
trol, it can’t be replaced while Filling In Forms protection is active.
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CAUTION!
Do not enable Filling In Forms protection mode when using Building Block Gallery con-

trols. These controls are not available to users when the document is protected for forms. 

In these cases, or when you want users to be able to format and edit any type of content 

inside controls, consider protecting part of the document in No Changes (Read Only) 

protection mode instead.

O The No Changes (Read Only) option does not allow any editing of the document. 
However, as with the Comments option, you can select portions of the document 
to make them freely available to all or just specifi ed users. 

When you need users to access Building Block Gallery controls, or to format and 
work with objects inside Content Controls, consider using the No Changes (Read 
Only) option with each of the Content Controls selected as exception areas that 
users can edit. To allow editing of Content Controls while in No Changes (Read 
Only) mode, select controls one at a time and click Everyone or select users to 
permit under the Exceptions section in the Restrict Formatting And Editing Pane. 
If you use this option, however, keep two things in mind.

P If the entire control is selected as an exception to the protection setting, 
users can still enable Design Mode and can still delete or edit the control 
(unless the options to restrict editing or deletion are enabled in the Content 
Control Properties dialog box).

P When a control is selected as an exception in this protection mode, place-
holder text does not behave like placeholder text. It behaves like user-edited 
text, which means that users can click in and edit placeholder text without 
being in Design Mode.

Once you’ve set the options you need, click Yes, Start Enforcing Protection. The dialog 
box that opens gives you the option to include a password. You’re not required to add 
a password. However, if you don’t add a password, or if users have access to the pass-
word, any user can unprotect the document.

Content Controls and Automation
As discussed briefl y in Chapter 9, the primary method of automation designed for use 
with Content Controls is the new Word data binding capability. This is XML functional-
ity that enables you to automatically populate controls with content from other sources. 
Document Property Quick Parts, discussed in Chapter 9, are examples of controls that 
are dynamically bound to data.

When a control is bound to data, the content in the control automatically updates when 
the bound data changes. Bound controls are bound in both directions, meaning that 
you can change data inside the control or inside the source data, and it updates in both 

C U O !
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locations. Controls can be bound to data in document properties or other custom XML 
that you add to the document, or to data in other locations, such as on a Microsoft Win-
dows SharePoint Services site.

Note, however, that only data suitable for controls with plain text properties (such as 
Plain Text controls, Date Pickers, and Drop-Down Lists) can be bound to Content Con-
trols. Rich text content (such as tables or graphics) is not supported for data binding in 
the 2007 release.

Learn how to bind controls to custom XML data in Chapter 22. 

As with most new Word features, Content Controls are also available as an object in the 
Word VBA object model, so that you can use macros when appropriate to act on them.  

Note
For SharePoint developers and those who use Visual Studio Tools for Offi ce to create 

managed code for the programs of the 2007 release, note that these platforms are not 

addressed in the automation components of this book. The automation-related content 

in this book provides a thorough introduction to the programming platforms for the 

2007 Offi ce release that don’t require the use of professional development platforms. 

Offi ce Open XML and VBA are covered because advanced users can use them to take 

documents and templates further without having to be professional developers and 

without having to purchase additional software beyond the Microsoft Offi ce programs.

However, for those who want to take their Microsoft Offi ce programming to the next 

level, fi nd additional resources and recommended references at the end of Chapters 21, 

22, and 23, “Using VBA and XML Together to Create Add-Ins.”  
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2007 Offi ce release that don’t require the use of professional development platforms. 

Offi ce Open XML and VBA are covered because advanced users can use them to take

documents and templates further without having to be professional developers and 

without having to purchase additional software beyond the Microsoft Offi ce programs.

However, for those who want to take their Microsoft Offi ce programming to the next 
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